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20.   Appendix 1 “Term 2K Short  Guide” 
 
Overview 
 
With reference to what described at Section 15. “USB / RS 232 PORTS usage”, this 
appendix contains the following sections: 
 
SW installation 
Term_2K_USB.exe usage 
Term_2K_232.exe usage 
Firmware update 
 
The host PC must have a correctly installed Windows XP or a further release of 
Microsoft’s operating system (Windows Vista, Windows 7); just a minimum RAM 
amount and hard disk space is required. 
 
20.1   SW installation. 
 
The installation package is contained into a compressed .ZIP archive named 
“Term_2K_Package_2_0.zip” which requires to be expanded in a working folder and 
then processed as hereafter described. This package in recorded into the equipped CD 
or can be downloaded from our website www.linear-amplifier.com . 
 
Once the compressed archive Term_2K_Package_2_0.zip has been previously stored 
into a working folder. It must necessarily be expanded, that is all the files therein 
contained must be extracted and properly placed to the host system. 
In this example the compressed archive Term_2K_Package_2_0.zip has been placed 
into a folder named Tmp which is contained into the local disk unit C: as shown in the 
picture below: 
 
 

 
 
The next step is the archive expansion, and this can be obtained by selecting the 
filename and then right-clicking over it; a local menu will appear, and its Extract All… 
item will pop-up the following pre-compiled form:  
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The proposed destination folder is good for our purpose, so let’s close this operation by 
using the Extract key marked in the picture above. 
 
This final result will be a new uncompressed folder  having the same name of the 
compressed one belonging to the original installation package. 
Everything is contained into our working directory  as shown in the picture below: 
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Once opened, the Term_2K_Package_2_0\Term_2K_Package_2_0  will show the 
following folder contents: 
 
 

 
 
Where: 
 
FT_232_RL  is a folder containing the USB drivers and an automatic installation 
program, which must be run once to prepare the operating environment and that 
provides to sort out everything  is needed (USB drivers and their support files…) on the 
Windows host system. 
Term_2K_USB.exe  is the remote control application that can be launched only after 
having properly installed the USB drivers. 
 Term_2K_232.exe  is the remote control application especially designed to establish a 
connection using the special RS-232 serial port available on the EXPERT 2K-FA 
Second Series rear panel  (that hardware is not available on First Series units). 
 
After a left-button mouse click the following folder report will appear: 



 User manual EXPERT 2K-FA
 

The most interesting thing for us is the CDM20600 folder which contains, among the 
other things, the CDM20600.exe Windows application marked in the picture below: 
 

 
 
This application has the purpose of properly installing the USB drivers. 
So, without making any physical link between the EXPERT 2K-FA and the PC, let’s 
double-click, using the mouse left-button, over the “red ball” icon of CDM20600.exe 
application and wait for its preparatory job completed. 
 
As soon as CDM20600.exe starts running, a DOS windows similar to one of the 
following picture will pop-up for several seconds and it will disappear after its automatic 
preparatory job’s completion. 
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The next step is to connect the PC and the EXPERT 2K-FA using the equipped USB 
cable and  wait the recognition of the new USB connection. 
After then a notification windows will pop-up, as shown in the picture below. 
 
 

 
 
The USB port installation and setting is now complete. 
Now that this fundamental step has been successfully completed,  the 
Term_2K_USB.exe remote control application can be launched. 
For this purpose a back-step to the starting uncompressed folder 
Term_2K_Package_2_0 must be made and a double-click with the mouse left-button 
on the application filename must follow it, as shown in the picture below 
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20.2    Term_2K_USB.exe usage 
 
It is warmly suggested to create a link to the application on the desktop. 
 
As a first try, let’s double-click on the application’s icon (the USB symbol), using the 
mouse left-button,  just to see if everything works fine. 
It is warmly suggested to create a link to the application on the desktop. 
As a result the application window will show off, as in the following picture: 
 

 
 
This is the main window of Term_2K_USB.exe application. 
It is a realistic hardcopy of the EXPERT 2K-FA LCD display, and it is also equipped with 
a pop-up virtual keypad having almost the same look and feel as the rear one placed on 
the EXPERT 2K-FA front panel. 
To activate/deactivate this keypad the user must check/uncheck the View/KeyPad 
On/Off menu item as shown in the following screen snapshot: 
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View menu also contains five items related to the application window size presets which 
can be either selected by the menu itself or by their equivalent [F1 … F5] shortcut keys. 
Feel free to test all the View menu options in order to find an optimal ad comfortable 
vision of the display main window. 
 
 

 
 
Anyway the display window can be easily  redimensioned (that is: enlarged or 
reduced…) by acting on the right-bottom corner of the window using the mouse as 
depicted in the picture above. 
In case the user wants to restore the original size-preset behind any [F1…F5] key, he 
must select the Fx preset and, then, press the Ctrl+Fx key combination on his PC 
keyboard. 
 

 
 
When Term_2K_USB.exe gets launched an automatic Connect command also starts 
and, if a USB link to the linear amplifier was already active, it should have shown a 
result similar to the picture sequence above. 
In case it won’t happen, the user can also try connecting using the File/Connect menu 
item (or using its equivalent Ctrl+Q shortcut  key…). 
 
The final visual result will be a “bright backlight” display and a function-keys enabling on 
the virtual keypad. 
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In case the EXPERT 2K-FA were already switched on after the connection established 
by Term_2K_USB.exe, an immediate update on the current display contents would 
result. 
In case the EXPERT 2K-FA were switched off, it would be turned on by using [ON] 
virtual key on the application keypad. 
 
The same way, all the other virtual keypad keys perform the same actions as their 
equivalent mechanical keys forming the real front panel keyboard of the EXPERT 2K-
FA. 
 
 

 
 
 
View menu is also equipped with the useful Home… and Park… items which have 
been  especially designed to allow an automatic repositioning of the application along 
the PC desktop area. 
In more details: 

• Home... (Ctrl+H) item positions the display window to the upper-left corner of the 
desktop area and aligns the keypad to its bottom edge. 

• Park...  (Ctrl+N) item leaves the display window where it currently stays and just 
aligns the keypad to its bottom edge. 

 
The above described operations could be helpful whenever a quick and safe 
repositioning of the application windows is required. 
 

 
The Basic keypad... item in View menu allows to set a reduced-size keypad, having 
fewer keys than the complete keypad, which could be useful when no setting actions 
are required on the linear amplifier. 
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Note: despite the keypad types (Full and Basic) are certainly useful since they  both can be 
directly accessed using the mouse pointer, it is helpful to know that all the operations allowed 
using the virtual keys can be also performed using short commands  directly typed  on the PC 
keyboard. 
 
The following one is the “shortcut-keys” table: 
 

2K-FA 
Function key 

Equivalent shortcut-key 
from the PC keyboard 

[INPUT] I 

[ANT] A 

[<L] Ctrl+L 

[L>] L 

[<BAND] Ctrl+B 

[BAND>] B 

[<C] Ctrl+C 

[C>] C 

[TUNE] U 

[DISPLAY] D 

[< -] -  

[> +] + 

[ON] N 

[POWER] P 

[CAT] T 

[SET] S 

[OFF] (*) F 

[OPERATE] O 
 
 
(*)  Please bear in mind that [OFF] command (either from virtual keypad or by shortcut 
key…) always asks for a confirmation to its amplifier shutdown operation by using the 
dialog form below: 
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Note: it could happen that, trying to connect the linear amplifier to the PC, some problems could 
arise because other peripherals sharing the same USB internal hub conflicts to it. 
To avoid this kind of conflict it is necessary to go to selective addressing. 
 

 
Selective addressing thru USB port. 

 
This options has been designed to allow  a selective addressing of an EXPERT  linear 
amplifier connected to any given PC USB port. 
Differently from other similar devices using the popular FT232RL USB microcontroller, 
where the most used way for providing selective addressing of a specific device is 
based upon its serial port ID parameter (e.g. COM1, COM2, etc.), or method is based 
upon a unique feature of the popular FTDI chip which is known as “ID String Property”. 
This is a sequence of 8-alphanumeric characters, programmed by the FT232RL’s 
manufacturer during the production process, which something similar to the MAC 
address peculiar to any  PC LAN card. 
From here the consideration that this unique coding parameter doesn’t allow addressing 
ambiguity when correctly applied to FDTI chips connected to the same USB bus. 
 
 

Preliminary programming for  “ID string property” within Term_2K_USB.exe . 
 
This special setting, based upon an easy “self-learning” procedure, must be performed 
once and with the EXPERT 2K-FA having previously put OFF-LINE. 
Select File/Configure USB connection... from the main menu as shown in the picture 
below: 
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A dialog window, as shown in the picture below, will pop up: 
 
 

 
 
The user is simply required to press the Acquire ID string key, marked in the picture 
above, in order to start the ID string characters acquisition process across the USB 
data-link (guided self-learning procedure…). 
In case more than one USB chip are linked to the system (directly or indirectly thru an 
external USB hub…) the following notification pop-up window will be shown: 
 
 

 
In such a case the user is invited to disconnect all the devices but his EXPERT 2K-FA 
and retry again using the acquisition procedure above described. 
 
In case the user detaches all the connected devices (the linear amplifier as well…) the 
Term_2K_USB.exe  acquisition system would notify that by rising the following self-
explaining pop-up message to the user: 
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In case of a successful acquisition process, the following pop-up notification message 
would  be raised instead: 
 
 

 
 
The picture above shows the acquisition report of a device whose ID String Property is 
A700embB. 
As explained earlier, this parameter is unique to any specific chip, so it doesn’t allow 
duplicates. 
As soon as the notifiation message gets validated, using its OK key, the dialog form 
previoulsy popped will appear properly filled-in as the following picture shows: 
 
Once the user validates the data acquisition by pressing the OK key marked in the 
picture above, the Term_2K_USB.exe internal database will be properly updated and,  
 
 

 
 
 
as a confirmation of that, the application status bar will be properly updated as the 
following picture shows: 
 



 User manual EXPERT 2K-FA
 

 

 
 
 
 
Once the above described steps get completed Term_2K_USB,exe, will only be able to 
recognize and address the EXPERT 2K-FA whose (unique) ID String matches to the 
one written after the USB_ID: label of the picture above. 
As explained earlier, this setting is permanent so, there is absolutely no need to repeat 
the acquisition procedure described so far any time the user wants to connect to that 
specific EXPERT 2K-FA unit. 
Of course the acquisition procedure must be restarted again in case another EXPERT 
2K-FA linear amplifier would require to be addressed; that is because another device 
has got, by force of circumstances, another ID String parameter to properly reconsider. 
 
After having carried out  all the setting and configurations steps listed in the earlier 
pages, everything’s ready for using the FT232RL selective addressing features 
described so far. 
 
All the operations tied to the Connect / Disconnect menu items are still the same as in 
the case of non-selective addressing procedure. 
 
 

A last note. 
 
If, for whatever reason, all the selective addressing capabilities are no longer needed to 
open a connection to an EXPERT 2K-FA thru its USB link, they can be temporarily 
disabled. 
 
This operation is quite easy to perform. 
After having recalled the Configure USB connection dialog form using its specific item 
contained into the File menu, uncheck with a mouse click the Enable ID Addressing 
option, as shown in the following picture, and validate this entry using the OK button. 
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This new setting will be notified in the application status bar with the “Not enabled” 
attribute following the USB_ID: label, as shown below 
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20.3    Term_2K_232.exe usage 
 
To start running Term_2K_232.exe application it is necessary to step back into the 
Term_2K_Package_2_0 uncompressed folder and select the related filename as 
shown in the picture below: 
 

 
A suggestion is to create a link to the application  and to place it over the Windows 
desktop. 
A double-click using the left-button of the mouse on the application icon should give out 
a result as the one shown in the following picture: 
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After then select File/Virtual Com Port setting. 
 

 
 
The above mentioned menu item makes it possible to access the following dialog box, 
which allows a direct setting of the desired COMx serial port for connecting the 
EXPERT 2K-FA. 
 

 
 
With all the serial resources connected go to Control Panel >>> Hardware and Sound 
>>> Device Manager and choose a serial COM listed in the HW configuration but  not 
used by other applications. 
In case USB-to-RS232 serial converters are being used, proceed as explained and 
check all the COM ports polled by the system. 
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To check a COM port identifier related to any given adapter, disconnect it and detect 
which COM item disappears from the proposed list after that configuration change. 
In case use that COM identifier to properly set  the Virtual Com Port dialog box shown 
in the picture above.. 
 
The available selection range spans thru the [COM1…COM256] set, and it can be 
accessed using the framed slider placed above the OK and CANCEL keys. 
 
All the other communication parameters are set as follows: 
Baud-rate: 115200 
Bit per character:  8 
Parity check: No 
and cannot be changed since they got programmed during the “SW installation” 
procedure. 
 
As mentioned above, the application usage is still the same as in ths USB interface 
version described earlier, while the display window backlight changes to ivory-white as 
shown in the picture below: 
 
 

 
 
Using the RS 232 port becomes a necessity when the device needs to be remotized via 
the Internet, since most of the committed devices currently on the market don’t 
implement a USB port feature. 
To be noted that in this peculiar version [ON] and [OFF] keys got intentionally disabled. 
Tha is because switch-on and switch-off operations on the linear amplifier are directly 
driven by the remotized transceiver (see Section 13.2 “REMOTE ON Connection” on 
the User’s Manual), while for the serial interface cable wiring consult Section 13.5 
“Port Connector”. 
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20.4   Firmware update  
 
A very useful function of Term_2K_USB.exe  is the one which enables us to update the 
built-in firmware of the linear amplifier. 
 
To update the linear amplifier it is needed a suitable .PK1 firmware file, which must be 
downloaded from our website www.linear-amplifier.com and then stored into a proper 
working folder. 
Switch the linear on, and keep it set to STANDBY mode during the firmware update job. 
 

 
 
Under these conditions the File\Firmware update  menu item is active and, upon its 
selection it sets the EXPERT 2K-FA to its firmware update mode (FIRMWARE 
UPDATE PROCEDURE). 
 
After then a dialog box will pop-up, and the user is allowed to select a proper firmware 
package whose data must be sent to the linear amplifier to update all its embedded 
functions 
 
In the example of the picture below a firmware package file named 12_05_12_G.pk1 
has been selected:  
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After a necessary confirmation by the user for validating the procedure, the EXPERT 
2K-FA switches its display off and the overall control for updating actions gets 
transferred to Term_2K_USB.exe application 
 
The main steps of firmware update procedure are the following ones: 
 

1. Checking and validation of updating firmware package 
 

 
 

2. A physical data sending of the new firmware from the PC to the linear amplifier  
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3. A final validation for the completed firmware update   
 

 
As a very last action after a successful firmware update, the linear amplifier performs a 
general auto-restart operation and, after then, a full control of the updated device is 
given back  for both local and remote operations. 
The user is then enabled to check the result of his firmware update operation directly on 
the LCD display (both real and virtual…) by pressing the [CAT] key twice. 
This action will show 
This operation will update the display report as shown below. 
 
 

 
 

 
 
 




